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UHBX-SW3 

1. Windows™ Software Installation 

1.1. General 
The UHBX-SW3 graphical user interface (GUI) is a Windows® software used to configure 
advanced settings of the UHBX-SW3. Use of the software requires USB connection of 
the PC to the device. For convenience, a USB cable is provided with the switcher. 

After configuring the switcher, the user can save the desired configuration as a file on 
their PC. Configuration files can also be uploaded to switcher. 

1.2. Installation Prerequisites 
• PC with Windows™ XP™ OS or later 

• USB port  

• Microsoft™ .NET Framework 2.0 or later (most recent OS including Windows™ 7 
and 8 typically include this and no action is required). If .NET Framework 2.0 or later 
is not installed on your PC, the Microsoft™ website has free downloads available.  

1.3. Installing the Software 
• Download the GUI from the product’s webpage. 

• If an earlier version of this software was previously installed, UNINSTALL the 
program first from either the Add/Remove Programs section of the control panel or 
by running the previous installation SETUP.EXE and selecting “remove application”. 

• Install the software by executing the SETUP.EXE program from the installation 
source directory 

• Accept the default settings, but if you want to specify a particular installation 
directory other than the default, you may do so. 

• Once the UHBX-SW3 software installation has completed, either click the desktop 
icon  
 
or from the Start Menu:  
Start  Programs  Hall Research  UHBX-SW3 
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2. Using the Software 

2.1. General 
The UHBX-SW3 Manager is a Windows™ software that can be used to configure the 
auto-switching switcher via a USB connection. 

It provides the ability to configure power commands using RS232. Additionally a few IR 
protocols are supported, but since IR codes are not readily available, use of IR power 
command is not recommended).  If an optional SW3-UI-VOL auxiliary control keypad with 
Volume buttons is used, the GUI also allows definition of Volume UP/Down, Mute, and 
Unmute commands.  

The software allows tweaking of parameters such as: prioritizing the inputs in Auto 
Source mode, locking or unlocking the Auto modes, and controlling the VGA Scaler's 
parameters such as underscan (zoom out), aspect ratio, brightness, etc. 

The GUI can save and load a configuration file into or from the device, and can be used 
to easily update firmware in the UHBX-SW3. 

2.2. USB Device Detection 
The Manager Software automatically configures the USB port after connection to the 
device. No special USB driver installation is required by the user. 

The first time you connect the device to a PC, you may experience a short delay while 
Windows™ automatically installs the required USB drivers. This only happens once.  

 Notice   For the PC to communicate with the switcher,  the UHBX-
SW3-WP needs to be receiving power through its HDBaseT 
Cat6 cable (POH). So it needs to be connected to a PSE 
receiver such as UHBX-R-PSE. 
 
If you start the Manager software without the USB port 
attached, the on-screen fields are disabled (grayed out). 
The instant you connect the USB cable, the GUI fields will 
become active.  
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2.2.1. USB Connection Status 
The GUI shows USB connection status and the number of detected SW3 switchers on 
the bottom right corner of the status bar. If no USB device is detected the Status bar 
shows a message indicating that the GUI is waiting for a connection as shown below. 

 GUI is waiting for USB connection to switcher 

 GUI has detected one device connected 

2.2.2. USB Device Name 
You can assign a unique USB device name to each switcher. The device names are 
stored on the switchers. By default all switchers are called USBDEVHR as shipped but if 
you are going to configure a number of switchers differently, then you may wish to assign 
different names to them that indicates room number or configuration type. 

The USB device name is shown near the top right of the screen under the toolbar. Click 
to change the name. A maximum of 8 characters can be used.  

 

2.3. Configuration Pages 
There are 2 configuration pages: 
 

• On/Off Control  - can be used to: 
o Define RS232 (or simple IR) commands for controlling the power 

state of the display or the volume (requires SW3-UI-VOL keypad). 
o Define the Auto/Manual mode of Power Command 
o Lock the Power Command in Auto or Manual mode so they cannot 

be changed from the buttons on the device 
 

• Video - can be used to: 
o Assign priorities to the 3 video inputs for Auto Source selection mode 
o Define the Auto/Manual mode of Source Selection 
o Lock the Source Selection in Auto or Manual mode 
o Configure the VGA Scaler for special applications 
o Configure and monitor the HDBaseT® output 
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2.3.1. On/Off Control Page 

 
The UHBX-SW3 Manager provides you more control and flexibility of the device than the 
front panel. 
 
Power Command Mode 

For sending on/off power commands to the display, there are two different modes the 
UHBX-SW3 device can be set to: manual and auto  

 
 Manual – In this mode, each Power button press on the physical switcher (or using 

the Last Command dropdown from GUI) will alternate between sending the Power 
On or the Power Off command to the display.  

 Auto – When the device is set in this mode, it will automatically issue power 
commands based on detecting video on the selected input.  As soon as a video 
source is plugged in to the selected input, the device will send out the pre-
configured power on command, and after video is disconnected, the switcher will 
wait for some time (typically 5 minutes), and issues the power off command. 
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 Auto Lock – This is the auto mode as mentioned above with lock enabled, which is 
locking the user from using the wall-plate power button to switch it to the manual 
power mode. If you want to keep users from being able to inadvertently disabling the 
Auto mode, you can lock it from the GUI. The only way to exit the lock mode is 
through using the GUI. 

 Manual Lock – This is a locked manual mode. When the device is in this mode, the 
user will not be able to switch to auto power mode using the wall-plate. He or She 
has to use the GUI to switch it to auto power mode when needed. 

Last Command 

The last command is only enabled in the manual power mode. It has the same effect as 
pressing the power button on the switcher. It toggles power on the switcher and causes it 
to also issue on or off commands to the display. 

When the device is turned off, all LEDs will be off. When it is turned on, it will return to its 
previous state before shutdown. 

Auto Off Delay 

When Power Command mode is set for Auto, and there is no video being detected, the 
auto off delay is defined as the time the device will wait for video to show up before 
sending out the pre-configured power off command to the display.  

After receiving a Power Off command, some projectors ignore further commands for 
some period of time (typically 30 seconds to a minute). We recommend that the user test 
their projector and determine the time it needs to get ready to process commands. Then 
you can enter a time delay as part of the Off Command string. This way, if just after 
sending the off command the video is reconnected, the switcher will wait for the inserted 
delay to expire before issuing the On command (without the Delay in the off command, 
the On command may not be received). 

Power Command Definition 
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The UHBX-SW3 allows the user to configure power ON and OFF commands using either 
RS232 serial or IR. IR can only be used if the exact protocol of the IR (such as RC5, 
NEC, etc) and the address and data bytes for the button are known. This information is 
typically hard to come by!  We recommend using IR only if you are 100% certain and 
verified that you have such information. Furthermore, even if that information is available, 
if separate On and Off IR commands are not available for the TV, it is possible to get the 
system out of sync with the display. Therefore, it is highly advised to use RS232 
whenever possible. Also remember that the switcher provides an IR detector and for 
simple installations, the user can just point the remote to the switcher and extend it to the 
display. 

A command can be up to 40 bytes long, and it can be a combination of serial, IR, and 
delay commands.  

 Function – It is used to select an on or off command to configure. 

 Protocol – It consists of serial and IR to use for a protocol. 

Serial Commands 

 A serial command can send data to any standard serial device with selectable baud 
rate and parity. 

 Hexadecimal characters may be entered by using &h in front of the 2 digit 
hexadecimal character (e.g. &hBE&hEF&h00&h00&h01). Hitting Enter on the 
keyboard will insert &h0D (carriage return). 

 Commands are entered in the command text box. When done, you can click the 
Add button to append the command as shown in the figure above. 

 Notice   When you enter a serial command, the software 
automatically unchecks Power Management box (see 
section 2.3.2). This is because if power management is on 
the system will put the HDBaseT link in low power mode. 
Transitioning to this mode causes a spurious pulse to 
come out of RS232 TX pin. If the device being controlled is 
sensitive to this pulse it may not recognize the next valid 
command. So by default when there are RS-232 
commands, the system will try and keep the HDBaseT link 
active at all times to avoid getting the extra pulse. 
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IR Codes 

As cautioned above, IR can only be used if the exact protocol of the IR (such as RC5, 
NEC, etc) and the address and data bytes for the button are known. It is only for the most 
advanced customers who actually have access to the IR data. Hall Research does not 
provide IR commands. 

 Supported IR formats are: NEC, JVC, RCA, RC5, Sony, Extended NEC, Samsung, 
and Sharp.  

 Select the desired IR protocol and enter address along with command. When done, 
just click the Add button to append the command. 

 
 

Inserting Delays in Commands  

 
A time delay can be added to a command string between multiple serial or/and IR 
commands if needed.  
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In the above example, as part of the Power On command the device also sends a Source 
selection to the TV after a brief delay (just in case someone had inadvertently switched 
the TV input away from the HDMI that is connected to the switcher). 

2.3.2 Video 

 
 
Active Video Input 

The UHBX-SW3 has a total of three inputs : HDMI1, HDMI2, and VGA. 

 HDMI1 – This input can be used for either an HDMI or a MHL source. 

 HDMI2 – This input is only used for HDMI source. 

 VGA – This input can be configured as VGA, component, or audio only source. 
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Input Switching Mode 

The UHBX-SW3 can select inputs either manually or automatically.  

 
 Manual – In this mode, each SOURCE button press will select the next input.  

 Auto – When the device is set in this mode, it will automatically switch to an input 
with the highest priority as soon as it detects its presence.  

 Auto Lock – This is the auto mode as mentioned above with lock enabled, which is 
locking the user from using the switcher's SOURCE button to switch it out of Auto 
and in to Manual mode.  

 Manual Lock – In this mode, the device is locked in the manual mode. The user will 
not be able to switch to auto input mode from the wall-plate, but it can be done from 
the GUI or in RS232 slave mode. 

 Notice   When the VGA input is configured for YPbPr 
(component video), Auto Source selection will not be 
able to detect the source. So in this case Auto Source 
mode is not available and users have to manually select 
inputs.  
 
Similarly, when the VGA input is configured for Audio 
Only, (can pass audio input with or without VGA 
connection), then with just an audio connection 
(without video), the device will not be able to 
automatically switch to that input and it has to be 
selected manually. 
 
Configuring the VGA input for YPbPr or Audio Only, also 
will increase standby power consumption of the 
switcher and it will stay warm even if no input is 
connected. So enable those only when required. 
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Input Switching Priority 

Each input can be independently set to any priority level from 1 to 3. Level 1 is the 
highest priority, and level 3 is the lowest priority. If two inputs have the same priority 
level, then they cannot interrupt one another (then they will act as first-come-first-serve).  

EDID Mode 

EDID mode can be set to either pass-thru or emulate. 

 Pass-thru (Default) – This is a default mode. When set to this mode, the EDID 
passed to the source comes from a sink TV, LCD monitor, or projector connected to 
an output. 

 Emulate – In this mode, the internal default EDID is passed to the source. 

Power Management 

When it is checked, the UHBX-SW3 always monitors the presence of connected and 
active source and TV (hot plug detection of display). If neither is detected, the unit will go 
into low power mode.  

When it is not selected, the HDBaseT output of the UHBX-SW3 will always operate either 
in Auto or Long Reach modes.  

By default, the Power Management option will be off automatically when there is a serial 
command defined initially. If there is no serial command, the Power Management option 
will be on. 

 

VGA Input Control 

The VGA Input Control has the following selections: 

 Notice   When Power Management is active and the unit is in 
low power mode, there is a possibility of a “pulse” 
generated along the RS232 TX line of the HDBaseT 
output upon wake up. 
 
If this is a concern, the HDBaseT output of the UHBX-
SW3 can be set to stay on all the time by un-checking 
the Power Management option box. 
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 Auto Adjust – It is used to perform an auto adjust of the VGA input source on the 
display (will try to best fit the video to the output screen). 

 Aspect Ratio – The VGA input source can have its aspect ratio set to either 4:3 or 
16:9 

 

 Brightness – The level of the VGA source brightness can be set between 0-100. 

 Color – The level of the VGA source color can be set between 0-100. 

 Contrast – The level of the VGA source contrast can be set between 0-100. 

 Input Mode – It is used to configure VGA input as VGA, component, or VGA audio 
only. 

 Notice   By default the Aspect Ratio is set for 16:9. This is because 
most notebooks have a wide screen LCD. So when the 
user duplicates their notebook's LCD to the VGA output 
and connects it to the UHBX-SW3, eventually it winds up 
as a widescreen 1080p HDMI signal on the display. So a 
16:9 signal from the PC displayed as a 16:9 TV will have 
perfect aspect ratio.  
 
However, if the VGA source is a 4:3 format (such as 
800x600 or  1024x768), to avoid stretching the width of 
the image (thereby creating a flattened circle), you can 
select 4:3 aspect ratio in the GUI. This will instruct the 
scaler to put black bars on the sides of the output signal 
to keep the video shown on the HDTV as a 4:3 image.  
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 Horizontal Flip – The VGA source can have its image displayed in normal or in 
horizontal flip (good for teleprompting applications). 

 Output Scaling – The source at the VGA input can be set to either 720p or 1080p. 

 Vertical Flip – The VGA source can have its image displayed in normal or in vertical 
flip. 

 Zoom  – This is used to zoom out or zoom in the VGA input source on the display. 
This is particularly useful if the VGA image's edges are cut off by the bezel of the 
TV. For example if you don't see the Windows™ Start or Taskbar, you can zoom out 
to try and get the edge on the screen. 

HDBaseT Output 

The operating mode of HDBaseT output can be set to either Auto or Long Reach mode.  

 Auto - When set to Auto, the HDBaseT output will follow the current mode on the 
receiver. By default, it is the HDBaseT mode. 

 Long Reach - When set to Long Reach, the HDBaseT output will have the 
strongest signal from the sender to the receiver. However, this mode does not 
support deep color or 4K video. 

 

In addition to setting the HDBaseT operating mode, the GUI displays status such as link, 
video, and approximate Cat6 cable length. 

 Local Link – Standard, Long Reach, Low Power, and Disconnected 

 Video – Detected or None 

 Remote Local Link – Standard, Long Reach, Low Power, and Disconnected 

 Notice   When used with the recommended  UHBX-R-PSE receiver, 
leave the mode in Auto. It will then follow the mode set 
on the Receiver. 
 
The UHBX-R-PSE receiver has a Switch under the HDMI 
output connector that can change its mode between 
Standard and Long Reach modes.  
 
HDBaseT-Lite receivers (70 meter/ Class B) do not 
support Long Reach. So if you are using a receiver with 
Class B HDBaseT, select Auto in GUI. 
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 Approximate Length (m) – The cable length is measured in meters, and it is not 
applicable when the connection is in Long Reach mode. The calculation may vary 
according to cable quality. 

 Source / Sink Status – Source Connection / TV Connection detected or not 

Input Status 

The UHBX-SW3 provides status of the detected video signal on the selected input. 

 Video Type – The type of video can be HDMI, DVI, MHL, or VGA 

 HDCP – It will be either on or off depending on presence of HDCP encryption on the 
input. 

2.4 Operation Mode 
In a typical installation, the UHBX-SW3 is acting as the Master!  This means that the 
switcher can switch between its 3 video inputs either automatically or manually. 
Additionally the switcher can also be programmed to send Power On/Off commands to 
the remote display through the RS232 port of the remote receiver.  

If RS-232 data is sent back from the display device to the switcher, in Master mode, it is 
ignored and no action is taken. 

But what if you are planning to use a separate control system and want to control the 
entire room's AV setup. In that case you can use the RS-232 port on the UHBX-R-PSE 
Receiver to control the switcher. All operational aspects of the switcher can be controlled 
if you put the switcher in Slave operation mode. .  

 



 

 

Software Guide 

14 © Copyright 2016. Hall Research, Inc. 
All rights reserved. 

 

 

 Master (Default) – In this mode, the UHBX-SW3 can 
send programmed serial commands such as Power On, 
Power Off, Volume UP, Volume Down, Mute On, and 
Mute Off to a TV or a projector through UHBX-R-PSE, at 
any specified baud rate from (1200-115,200).  A typical 
button press will trigger the unit to send any corresponding programmed serial 
commands to the TV or the projector. 

 Slave – In this mode, the UHBX-SW3 can be controlled by another device through 
the UHBX-R-PSE receiver. In this mode the baud rate is fixed at 9600. The list of 
supported commands in Slave mode is shown in Appendix 1. 
 

2.5. Tool Bar Menu 
The UHBX-SW3 Manager toolbar consists of three main menus. 

File 

The File menu consists of the Exit selection as shown. 

 Exit – Exit the UHBX-SW3 Manager. 

Tools 

 Load Configuration – Get an existing 
configuration file from the PC. Configuration files 
are text files that contain all user configurations 
including all the setting parameters except VGA 
input color, contrast, and brightness. 

 Save Configuration – Save the current user 
configuration as a file on PC. 

 Factory Default – Restore the device to factory default settings. 

 Firmware Update – Allow you to update any future device firmware. 

 

Help 

The Help menu has the About selection as shown. 

 About… - Display the current version of UHBX-SW3 
Manager, device firmware, USB serial number, and UI 
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firmware. 

2.6. Firmware Update 
The firmware update can be found under the Tools menu.  When the Firmware Update 
is selected, the UHBX-SW3 Manager will open a Firmware Update window as shown.  
It is recommended to restart the GUI after the firmware update. 
 

 

 

 Notice   If the SW3 device has a custom configuration 
programmed (such as RS-232 commands) and if you 
have not saved the configuration file on your PC, then 
prior to updating the firmware, you should first 
download and save the existing configuration to your PC 
from the SW3. After firmware upgrade to a new version, 
the unit will perform a “factory default setting” erasing 
any special configuration that may be in the device. 
 
 You can still upload a configuration file even if it was 
created using previous versions of firmware or GUI to the 
SW3 with new firmware. 
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Appendix 1  -  Serial Commands in Slave Mode 
 Power: 

Command:  PWn <cr>     Stands for Power On 
Response:   PWn <cr>     Where n = 0 - 1 = Power Off - On 

 
 Auto Power: 

Command:  APn <cr>      Stands for Auto Power 
Response:   APn <cr>      Where n = 0 - 3 = Auto Power Off (Manual Power) – On 

               – On Lock – Auto Power Off (Manual Power Lock) 
 Input Select: 

Command:  ISn <cr>        Stands for Input Select 
Response:   ISn <cr>        Where n = 1 - 3 = HDMI1 - HDMI2 - VGA 
 

 Auto Input: 
Command:  AIn <cr>        Stands for Auto Input 
Response:   AIn <cr>        Where n = 0 - 3 = Auto Input Off (Manual Input) – On 

               – On Lock – Auto Input Off (Manual Input Lock) 
 Off Delay: 

Command:  ODn <cr>      Stands for auto Off Delay 
Response:   ODn <cr>      Where n = 0 - 240 (in minutes) 
 

 Switch Priority: 
Command:  SPn,m <cr>  Stands for input Switching Priority 
Query:   SPn <cr>       
Response:   SPn,m <cr>  Where n = 1 - 3 = HDMI1 - HDMI2 - VGA 
      (m = 1 - 3 (highest - lowest priority level) 
 

 Operation Mode: 
Command:  OMn <cr>     Stands for Operation Mode  
Response:   OMn <cr>     Where n = 0 - 1 = Master – Slave 
 

 Low Power: 
Command:  LP <cr>        Stands for Low Power  
Response:  LPn <cr>      Where n = 0 -1 = Normal – Low Power 
 

 Mute: 
Command:  MTn <cr>     Stands for Mute LED 
Response:  MTn <cr>     Where n = 0 -1 = Off – On 
 

 VGA Auto Adjust: 
Command:  AA <cr>        Stands for VGA Auto Adjust 
Response:   AA <cr>      
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 VGA Aspect Ratio: 

Command:  ARn <cr>     Stands for VGA Aspect Ratio 
Response:   ARn <cr>     Where n = 0 - 1 = (4:3) – (16:9) 
 

 VGA Brightness: 
Command:  BNn <cr>      Stands for VGA Brightness 
Response:   BNn <cr>      Where n = 0 -100 
 

 VGA Color: 
Command:  CLn <cr>      Stands for VGA Color 
Response:   CLn <cr>      Where n = 0 -100 
 

 VGA Contrast: 
Command:  CTn <cr>      Stands for VGA Contrast 
Response:   CTn <cr>      Where n = 0 -100 
 

 VGA Input Configure (Mode): 
Command:  ICn <cr>      Stands for VGA Input Configure 
Response:  ICn <cr>      Where n = 1 - 3 = VGA – Component – Audio only 
 

 VGA Left to Right (Horizontal Flip): 
Command:  LRn <cr>      Stands for VGA Left to Right 
Response:   LRn <cr>      Where n = 0 -1 = Normal - Reversed 
 

 VGA Output Scale: 
Command:  OSn <cr>      Stands for VGA Output Scaling 
Response:   OSn <cr>      Where n = 0 -1 = 720p – 1080p 
 

 VGA Top to Bottom (Vertical Flip): 
Command:  TBn <cr>      Stands for VGA Top to Bottom 
Response:   TBn <cr>      Where n = 0 -1 = Normal - Reversed 
 

 VGA Underscan (Zoom): 
Command:  USn <cr>      Stands for VGA Underscan 
Response:   USn <cr>      Where n = 1 - 6  
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 Status Update: 

Command:  SU <cr>        Stands for get full Status Update 
Response:   PWn <cr>  APn <cr>  ISn <cr>  AIn <cr>  ODn <cr>  SPn,m <cr>  ARn 

<cr>  BNn <cr>  CLn <cr>  CTn <cr>  ICn <cr>  LRn <cr>  OSn <cr>  
TBn <cr>  USn <cr>  FWx.x <cr>   

 
 Factory Default: 

Command:  FD <cr>        Stands for Factory Default 
Response:   FD <cr>      
 

 Firmware Version: 
Command:  FW <cr>       Stands for Firmware Version 
Response:   FWx.x <cr>  UHBX-SW3 Firmware Version 
 

 Button: 
Command:  BLn,m <cr>  Stands for Aux keypad Button LED 
Response:   BLn,m <cr>  Where n = 1 - 3 = PWR LED – MUTE LED 
       m = 0 - 1 = LED Off – LED On 

 Volume Up: 
Response:  UP <cr>       Stands for Volume Up 

   Sent when user pushes the Volume Up button on Aux Kpd 
 

 Volume Down: 
Response:  DN <cr>       Stands for Volume Down 

   Sent when user pushes the Volume Down button on Aux Kpd 
 
 Power Management: 

Command:  PM <cr>        Stands for Power Management 
Response:  PMn <cr>      Where n = 0 -1 =  Low Power option OFF - ON 

 
Error Commands 
ERR0 – UHBX-SW3 power is off.  
ERR1 – Invalid command 
ERR2 – The VGA scaler board is in low power mode 
 
 
 

 Notice   If n is not specified in any of the commands above, the 
command becomes a query command instead of a set 
command.  In response to a query command the system  
reports the current status of that command. 
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